
AccuTerm 7.1 Release Notes 

Release 7.1c-sp2 (06-24-2016) 

AccuTerm 7 is designed to run on Windows XP SP2 and above. It will not run on Windows 2000 or any 

Windows 9x or ME versions. It is a 32 bit Windows application, and requires an Intel x86 (32 or 64 bit) 

architecture CPU. It is not compatible with ARM processors (Windows CE, Windows Mobile, Windows 

RT). 

 

Upgrading from AccuTerm 7.1a to AccuTerm 7.1c 

AccuTerm release 7.1c provides updates to Secure Shell (SSH) and adds a new connection method: 

SSL/Telnet. An incompatibility in Windows 8.1 cryptographic support required a change in AccuTerm’s 

SSH crypto functions. SSH host key verification was also added in this release. See the highlighted 

sections below for details on the new SSH and SSL features. 

 

Upgrading from AccuTerm 7 to AccuTerm 7.1 

The main focus of AccuTerm 7.1 is to add support for Unicode to all AccuTerm functions. This includes 

supporting UTF-8 as a host character set encoding for terminal sessions (green-screen), file transfers, 

data capture, GUI Designer and Runtime and the wED Editor. 

Enhancements or changes which are new to AccuTerm 7.1 compared to AccuTerm 7 are denoted by 

shaded text. 

AccuTerm 7.1 should be installed in a separate directory from other versions of AccuTerm. AccuTerm 7.1 

does not share any common components with prior versions of AccuTerm. The default installation 

directory is C:\Program Files\Atwin71. The atwin.ini file has been renamed atwin71.ini. The application 

data directory is the same as for AccuTerm 7: C:\Users\username\AppData\Roaming\Asent\atwin70. 

This is where private menu files, the dialing directory and ssh key files are stored. 

Although the host programs from prior AccuTerm versions are upward compatible with AccuTerm 7.1, 

we recommend installing the new host programs from AccuTerm 7.1. The host programs have been 

updated to support Unicode / UTF-8 on platforms supporting these. The updated programs are designed 

to be backward compatible with any previous version of AccuTerm.  

Although you can run LOAD-ACCUTERM-PROGS from the ACCUTERM account on the host to install the 

updated programs, it is easier to use Update Host Program from the MultiValue menu. This will reinstall 

the base programs in the FTBP file first, then display a dialog where you can select the other libraries 

and samples that you want to reinstall. 



 

Upgrading from AccuTerm 2K2 to AccuTerm 7.1 

AccuTerm 7.1 should be installed in a separate directory from other versions of AccuTerm. Unlike 

previous AccuTerm versions, AccuTerm 7.1 does not share any common components with prior versions 

of AccuTerm. The default installation directory is C:\Program Files\Atwin71. The atwin.ini file has been 

renamed atwin71.ini and the application data directory has moved to 

C:\Users\username\AppData\Roaming\Asent\atwin70. This is where private menu files, the dialing 

directory and ssh key files are stored. 

Although the host programs from prior AccuTerm versions are upward compatible with AccuTerm 7.1, 

we recommend installing the new host programs from AccuTerm 7.1. If you use AccuTerm GUI, you 

definitely should install the new GUIBP library because there are several new subroutines included, and 

new constants defined in ATGUIEQUATES for new events, properties and methods. 

Although you can run LOAD-ACCUTERM-PROGS from the ACCUTERM account on the host to install the 

updated programs, it is easier to use Update Host Program from the MultiValue menu. Be sure to select 

the Reinstall FTBP first, then run the update again and reinstall the other desired programs (especially 

GUIBP). 

 

New MSI-based Installer 

The AccuTerm 7.1 installer has been redesigned using Microsoft Installer (MSI). The MSI installation file 

is wrapped in a standard EXE installer which allows the selection of the desired installation type. The EXE 

installer then launches the MSI install (msiexec) with appropriate options. As with AccuTerm 7, three 

installation modes are supported: normal (all users), personal (install for current user only), and 

portable (run from removable device). The silent install options have been changed from /q or /s to 

/SILENT or /VERYSILENT. The format of the setup.ini file used to customize the installation process has 

been changed. Please see the user manual or online help for more information.  

 

Product Activation 

The product activation has been updated in AccuTerm 7.1. The product can now be activated at any 

time without requiring a re-install. In the Help menu, there is a new selection: Enter Activation Code.  

The Activation form has a check box: Send registration details to Zumasys over the Internet. We 

recommend checking this box to register your copy of AccuTerm when it is activated. This will aid us in 

helping you in the event that you lose your activation code or have other support issues. 

 



Importing your Settings 

When you run AccuTerm 7.1 for the first time, AccuTerm checks if there are settings from older versions 

of AccuTerm that can be imported into AccuTerm 7.1. This is a one-time offer. It will display a list of the 

various settings that can be imported and you can choose which ones to import. 

The session configuration files, layout files and script files can be used without any changes. If you 

update the settings and save the configuration file from AccuTerm 7.1, you might not be able to use it in 

prior AccuTerm versions, as some settings are stored using different keys. If in doubt, make a backup 

copy of the file, or use Save As to save using a new name. 

 

New Features - Main Program 

In AccuTerm 7, the menu, toolbar, status bar and session bar were completely revamped. The old 

session bar has been replaced with a new tab set. You can right-click on a tab to display a context menu 

with options to activate, maximize, close, rename or clone the session. There is a drop-down arrow at 

the right edge of the tab bar to select sessions that are not currently displayed on the bar. 

The default font for new sessions is now DejaVu Sans Mono. This font has better hinting for small 

character sizes than the AccuTerm Legacy TrueType font, and has decent Unicode character set 

coverage. In prior versions of AccuTerm, the AccuTerm font consisted of hand-tuned bitmap fonts for 

smaller character sizes and TrueType fonts for larger sizes. Because Windows bitmap fonts do not 

support Unicode, the supplied AccuTerm Legacy (bitmap) font is limited to the Latin-1 (ISO 8859-1) 

character set. The supplied AccuTerm Legacy TrueType font may also be used, however due to poor 

hinting, rendering quality at small character sizes will suffer.  The AccuTerm Legacy True Type font also 

appears to have thinner strokes at larger sizes. The new DejaVu font is recommended. 

In AccuTerm 7, the Settings dialog box has been completely re-designed. The new interface uses a tree 

to select the category of setting to display in the main pane of the dialog. Using the tree interface has 

made the settings more logical. 

AccuTerm 7 supports independent settings for screen printing and slave printing. 

 Network features in AccuTerm 7 have been improved. IPV6 is now supported, as are "Internationalized 

Domain Names" (punycode). Support for D3 Device Licensing has been added to telnet and SSH. 

SSH has an additional authentication protocol: Keyboard Interactive. This protocol is similar to 

Password, but is host-driven. It is in common use on many Linux versions. The difference between 

Keyboard Interactive and Password authentication is that Keyboard Interactive supports password 

expiration and changing (if supported by the host). AccuTerm 7.1 SSH supports two additional 

encryption algorithms: Diffie-Hellman group 14 key exchange (previously, only group 1 was supported), 

and RSA signatures (previously only DSS signatures were supported, but some Cisco routers require the 



RSA signature algorithm). SSH now supports Putty format private key files, so you can import DSA and 

RSA private keys generated using Putty’s puttygen.exe program. 

AccuTerm 7.1 can be installed in “FIPS-140 mode”. Use the custom feature code FIPS140 to enable this 

mode during installation. In FIPS-140 mode, AccuTerm 7 SSH is restricted to FIPS-compatible algorithms 

when running on a Windows machine configured FIPS compliancy. While AccuTerm SSH itself is not FIPS 

certified, the encryption functions used by AccuTerm SSH are provided by the Microsoft Crypto API 

Library DLLs, which are FIPS certified when Windows is running in FIPS mode (see Microsoft KB811833 

for more information about FIPS mode). When running in FIPS mode, AccuTerm 7 is unable to create RSA 

keys, however you can import an RSA private key from another source, for example, a key created by 

puttygen.exe. Also note that OpenSSH private key files are not supported in FIPS mode. This is due to the 

use of MD5 hash to ensure the file has not been tampered with, and MD5 is not approved in FIPS-140. 

Since a large part of AccuTerm's market is the MultiValue community, those functions where are 

peculiar to MultiValue users have been consolidated into a new MultiValue menu group in the main 

AccuTerm menu. These features include the GUI Designer, wED Editor and File Transfer Wizard. There 

are sub-menus for installing, updating and configuring the host programs. 

There is now an option in FTD and FTEXPORT to use column headings instead of dictionary names in the 

heading row when sending data from the host to Windows. A new FTEXPORTDA subroutine has been 

added to the library to export a dynamic array passed as an argument instead of data from a file. The FT 

& FTD option “Convert OEM char set to ANSI” has been changed to “Convert character set”, since other 

character encodings are now supported. 

 

Unicode Support 

To use Unicode (UTF-8) as your host character set encoding, select "Unicode (UTF-8)" from the Host 

Character Set Encoding drop-down list in the Session Settings -> Terminal -> Font & Character Set page. 

Select a suitable font to support the language(s) you intend to use. Configure your host to use UTF-8 

encoding. 

Note: if you attempt to display characters that are not defined in the selected font, Windows "font 

linking" will attempt to use another suitable font for those characters. Sometimes the results are 

acceptable, but if the linked font does not produce suitable results, choose a font that includes all of the 

characters for the scripts you intend to display. 

At this time, only left-to-right text is supported. We plan on adding bidirectional support for mixed left-

to-right and right-to-left text in a future release. 

To send or receive files containing Unicode data using the AccuTerm file transfer programs, you need to 

select the desired text encoding for use on the Windows machine: Session Settings -> File Transfer -> 

Text File Encoding. If this setting is anything other than "no encoding" AccuTerm will save text files in the 

selected encoding. When sending text files to the host, the file's BOM (byte order mark) is used to 



determine the encoding and the content is transcoded from the file's encoding to host character set 

encoding. The BOM is not included in the data sent to the host. 

The AccuTerm host programs must be configured to enable character set conversion. On the ACCUTERM 

account, from TCL, type FTSETUP to configure the host programs. Choose item 3 (or 4), then set the 

"Convert character set" option to "yes". 

Note:  UTF-8 support in the AccuTerm host programs required some platform specific enhancements to 

the host programs. At this time, the following platforms include UTF-8 support: 

 QM release 3 and up 

 

SSH Enhancements 

Host key verification 

Verification of a server’s host key when establishing an SSH connection is a security feature that is 

standard in many other SSH implementations, but has not previously been supported by AccuTerm. This 

release addresses this issue by adding some new settings in the SSH configuration panel to specify the 

level of verification desired. The choices are: 

None: the host key is not verified and AccuTerm assumes that you are connected to the desired 
host. This is how all previous versions of AccuTerm have behaved. 

Trust on first use: if the key has not been established (first time you connect to a particular 
host), AccuTerm assumes that you are connected to correct host and its key is saved in your 
session configuration. The key is verified on subsequent connections. If verification fails, the 
connection is aborted.  

Confirm change: a dialog is displayed if a change in the host key for a particular session is 
detected. Confirmation is required to complete the connection. If the host is confirmed, the new 
key is saved in the session configuration, otherwise the connection is aborted. 

Verify host key fingerprint:  requires that the host key fingerprint be manually entered in the 
SSH settings. If the key verification fails, the connection is aborted. The fingerprint is the MD5 or 
SHA1 hash of the host key, in hex.  

If your host is running OpenSSH, you can use the ssh-keygen command to display the host key 

fingerprint and copy/paste the fingerprint into the Key Fingerprint box in AccuTerm’s SSH settings. The 

command to display the RSA host key fingerprint is: 

ssh-keygen -lf /etc/ssh/ssh_host_rsa_key.pub 

To display the DSA host key fingerprint, change “rsa” to “dsa” in the above command. 

Note: the ssh-keygen command displays the MD5 hash of the host key. You can use this fingerprint for 

host key verification unless you are running AccuTerm in FIPS-140 mode.  In FIPS-140 mode, the MD5 



hash algorithm is not supported, and you will need to use the SHA1 hash instead. At this time we are 

unaware of any Linux command to display the SHA1 hash of the host key. 

 

Default SSH2 cipher changed to AES 128 in CTR mode 

The default cipher used for SSH2 connections was changed from Triple DES to AES 128 bit in CTR mode. 

Security experts have discovered a weakness in CBC mode ciphers, and now recommend using CTR 

mode instead. This may affect the cipher used for SSH2 connections, if you are using the default cipher. 

 

SSL/Telnet Connection 

A new connection method, SSL/Telnet has been added to this release. This connection method 

establishes a secure SSL/TLS connection between AccuTerm and the host, then initiates a Telnet session 

within the SSL connection (tunnel). This provides privacy and optionally, authentication of both client 

and server. This connection method is provided primarily for users who need to connect to UniVerse, 

UniData and other MultiValue platforms running on Windows. These platforms do not support Secure 

Shell (SSH). Both UniVerse and UniData have support for SSL/Telnet. Other MultiValue platforms may be 

able to use this connection method by using an SSL proxy, such as stunnel. Please consult your U2 

documentation for server configuration instructions. Setting up the server for SSL is not a trivial task. At 

minimum, a self-signed X.509 Server certificate must be installed on the server for SSL/Telnet to 

function. 

In addition to the advanced Telnet options, which are the same for SSL/Telnet and normal Telnet, 

SSL/Telnet has options for validating the server certificate, and for specifying an optional client 

certificate. Server certificate validation can be selected from a drop-down list: 

None: any server certificate is assumed to be valid. 

Minimal: the server certificate’s name, role, expiration and root certificate authority are 
ignored. The certificate is rejected only if it has been revoked. 

Self-signed – disregard host name: the server certificate’s name, role and root Certificate 
Authority are ignored. The certificate is rejected if it is expired or revoked. 

Self-signed – verify host name: the server certificate’s role and root Certificate Authority are 
ignored. The certificate is rejected if the certificate Common Name does not match the host 
name specified in the “Host Name or IP Address” for the session configuration. It is also rejected 
if it is expired or revoked. 

Strict: the server’s certificate must be issued by a trusted Certificate Authority, and it must be 
valid for use as a Server certificate. It must not be expired or revoked, and the Common Name 
must match the host name specified in the session configuration (Host Name or IP Address 
field). 



Custom: various requirements for certificate validation can be individually selected, in the event 
that the typical validation levels are not appropriate for a given host. 

 

If the host requires client authentication, a client certificate can be selected from the drop-down box. 

The drop-down lists all client certificates installed on the user’s computer, showing the Common Name, 

the issuing Certificate Authority, and the certificate expiration date. The client certificate is used to 

authenticate the client to the server while establishing the SSL connection. Normal login credentials 

(user ID and password) may still be required to initiate the Telnet session. 

 

New Escape Sequences (AccuTerm Programming) 

Some new private escape sequences added to AccuTerm 7: 

 ESC STX p mode CR -  selects the printer mode:  
  mode = 0 - turns off auto or transparent print 
  mode = 1 - turns on auto print 
  mode = 2 - turns on transparent print 
  mode = X - turns off auto or transparent print and closes the print job immediately 
 

 ESC STX 2 -  Enables mouse input in SystemBuilder compatibility mode; turns on mouse cursor. 
Transmits mouse location whenever a mouse button is pressed.  
 

 ESC STX yj, name CR - queries status of a stored screen block. Sends a 0 or 1, followed by a CR, 

indicating if a block of the specified name exists in AccuTerm's screen block memory. Screen blocks are 

stored using ESC STX jS,... documented in the online help, AccuTerm 7 Reference chapter, AccuTerm 

Programming topic. 

 

 ESC STX iB, filename , scalemode , transparency CR - loads an image to use as the screen 
background (wallpaper).  
  filename - the path or URL of the image to use as the screen background. 
  scalemode = 0 - picture is stretched to fit screen size. This may alter the picture's aspect 
ratio. 
  scalemode = 1 - picture is scaled so that its longest dimension fills the screen. The area 
not filled by the picture is black. 
  scalemode = 2 - picture is scaled so that its shortest dimension fill the screen. The longer 
dimension is cropped. 
  transparency - a percentage - 100% means that the picture is the only thing seen in the 
background. 0% means that the screen background color is visible and the picture is invisible. Any 
percentage in between blends the picture with the screen background color. 
To clear the background image, simply use ESC STX iB CR. 
 

 ESC STX R script CR - this is a variant of the old ESC STX P command used to run a script. The 

difference with this command is that the script is synchronized with the terminal. This basically sets the 



session InputMode property to 1 before the script starts and restores it once the script completes. This 

ensures that any characters received from the host will not be processed by the terminal emulator 

unless they are first processed in the script using Input or WaitFor. This has the effect of buffering any 

data or escape sequences received while the script is running. This is useful when changing Session 

properties such as screen sizes, terminal type, etc.  

 

Previously, we recommended adding a final Output in scripts that required synchronization. This 

required a corresponding INPUT statement in the host program. However, this technique is not 

compatible with typeahead on the host. The new escape sequence solves this problem. 

 ESC STX w and ESC STX m  - these existing escape sequences can be used to play most types of 

audio media files, including mp3 files. 

 ESC STX iL,... -  this existing escape sequence is used to display images on the text screen. It has 

been updated to use the FreeImage Open Source image library, so more image formats are now 

possible. 

 

AccuTerm Object Model Changes 

 

Server object: 

The name of the server object provided by AccuTerm 7 has been changed from "atPickServer.Server" to 

"atMVServer.Server". You need to use the new name in your CreateObject() function to access the 

AccuTerm 7 version of the MultiValue server. If you are using a reference to the "AccuTerm 2K2 

MultiValue Server" type library, you need to change the reference to "AccuTerm 7 MultiValue Server". 

To make your code version-independent, declare variables that reference the Server object as Object 

instead of an explicit type. Attempt to create the server object using the new AccuTerm 7 name, and if 

an error occurs, try using the AccuTerm 2K2 name instead. 

 

AccuTerm object: 

MenuFileName property has been removed - this property has been obsolete since AccuTerm 2K2. 

TelnetHostsFile property is obsolete and has been removed. 

 

Session object: 

FKeys property and FKey object: the FKeys property returns an FKeys collection which acts like the 

FKeys() array property from previous AccuTerm versions so existing scripts should continue to 

work. Instead of containing strings, elements in the FKeys collection are FKey objects. The 

default property of the FKey object is the content of the key, which is a string. 

BackgroundPictureFile property has been added to support background pictures. 

BackgroundPictureMode property has been added to support background pictures. 

BackgroundTransparency property has been added to support background pictures. 

ScreenPrinterName, ScreenPrintPaperSize, ScreenPrintPaperSource, ScreenPrintOrientation 

properties have been added so that screen & slave printers can be configured independently. 



ScreenPrintAdapterScript property has been added to support use of a "print adapter script" to 

process screen printing. 

SlavePrinterName property has been added as a synonym for PrinterName property. 

SlavePrintAdapterScript property has been added to support use of a "print adapter script" to 

process slave print jobs. 

DeviceLicenseMode property has been added to supersede the old U2DeviceLicensing property (old 

property is still valid). 

BreakKeyAction property has been added to supersede the old TelnetAltBreak and 

SSHBreakCharacter properties (old properties are still valid). 

KeepaliveInterval property has been added and supersedes the old TelnetKeepalive and 

SSHKeepalive properties (which remain valid). The new property allows the interval to be 

specified which whas not possible using the old properties. 

TcpNoDelay property has been added and supersedes the old TelnetNoDelay and SSHNoDelay 

properties. 

TcpIdn property has been added to support "Internationalized Domain Names" or "punycode" for 

host names. 

TelnetKeepaliveIsNOP property has been added to select the telnet NOP command as a keepalive 

message (the default is the telnet DMARK command). 

SSHUseOnlyPreferredCipher property has been added. 

OnLine property has been added. Set this property to True to connect or False to disconnect. 

CopySelMode property has been added to support new "remove selection after copy" feature. 

GetSelection method has been added to return coordinates of selection (instead of selected text 

returned by the Selection property). 

Copy method has been changed so that the last line copied to the clipboard does not have a 

terminating CR/LF appended. 

Server, MenuFileName, DDEResult, ScrAutoFwd properties are obsolete and have been removed. 

TelnetEcho, TelnetAltBreak, TelnetNoDelay, TelnetKeepAlive, SSHNoDelay, SSHKeepalive, 

SSHBreakCharacter and U2DeviceLicensing properties have been superseded by new properties 

listed above. These properties continue to function, however their use is discouraged. 

FontSize and PrinterFontSize property type has been changed from integer to float. 

TextFileEncoding property specifies the encoding used for capture files or received text files. Set to 0 

for raw (no encoding), 1 for ANSI, 2 for Unicode and 3 for UTF-8. 

 

Settings object: 

Generally, the same properties that were added, removed or superseded in the Session object have 

been similarly updated in the Settings object. Instead of TextFileEncoding, the Settings object has a 

DefaultTextEncoding property. 

 



New Features - GUI 

The following sections describe the new features that available in AccuTerm 7 GUI. Note that there are 

still a significant number of items on the "wish list", so if your desired "wish" did not make the cut for 

this release, don't give up hope - it might make a future release. Generally, new features that were 

requested by multiple users are the ones that have been included, although, not all of these were 

feasible at this time. 

One of the main goals of AccuTerm 7 is to bring the user interface style up to the level of modern 

Windows versions. Every effort has been made to render the GUI objects according to the style used by 

Windows itself. Because of this, you are not guaranteed that colors or sizes will be 100% consistent 

between Windows versions, or even between the same versions with different themes, monitor sizes 

and screen resolutions. This might require a bit more flexibility by developers to ensure their 

applications look pleasant on a wide range of target systems. There is a system-wide setting in the 

atguisvr.ini file in the program directory. Add the item DisableThemes=True to the [Behavior] section of 

this file. You can create the file with Notepad if it does not exist. 

Most AccuTerm GUI objects have a "Border Style" property, with settings for None,  Flat and 3D. The 3D 

style has been renamed as "Normal". When using themes (the default) on Windows XP and later, the 

Normal border style will be rendered using the appropriate Windows border style for the particular 

object. With Windows XP and above, most borders are drawn using a flat style with colors compatible 

with the current Windows theme. 

AccuTerm 7 GUI has a "type ahead" feature, which was first introduced in AccuTerm 2K2 release 5.3c-

sp2. This feature buffers keyboard and mouse events while the host is processing events. So even 

though the user might not see the effect of a keystroke or click immediately, the short delay is typically 

barely noticeable and the GUI program appears to be more responsive than previous versions without 

the type ahead feature. There are several actions that clear any buffered events from the type ahead 

buffer: calling ATGUIACTIVATE, calling ATGUISUSPEND or ATGUIRESUME and switching to a different 

Windows application. 

The GUI Designer has new default font and scale mode preferences which will be used whenever a new 

project is created (Tools -> Settings). Also, a setting to disable designer extensions has been added. 

The alignment of borderless edit controls has been changed to work the same as borderless label 

controls. The text baseline of an edit control at a given vertical position, height and font will be aligned 

with the baseline of another edit control or label control at the same position, height and font, 

independent of the Border property of the controls. 

 

New Controls: 

Timer 



ATGUICREATETIMER(APPID, FORMID, CTLID, STYLE, TIMEOUT, GUIERRORS, GUISTATE) 

The ATGUICREATETIMER routine creates a timer control that fires a Timer (GETIMER) event after a 

specified interval. The timer may be one-shot by specifying STYLE = 0 or repeating by specifying STYLE = 

1. For one-shot timers, you can restart the timer by setting the Enabled (GPENABLED) property to True 

(1). For repeating timers, setting Enabled (GPENABLED) to False (0) will disable the timer. Specify 

TIMEOUT  in milliseconds. The TIMEOUT value can be changed at any time by setting the Timeout 

(GPTIMEOUT) property. Using the timer control may be more convenient than calling 

ATGUICHECKEVENT with a timeout because the interval can be controlled more precisely. Multiple 

timers are supported. 

 

HTML Viewer 

ATGUICREATEBROWSER(APPID, FORMID, CTLID, PARENTID, EVENTMASK, URL, LEFT, TOP, WIDTH, 

HEIGHT, GUIERRORS, GUISTATE) 

The ATGUICREATEBROWSER routine creates an HTML Viewer control, which is currently implemented 

using a component version of Internet Explorer. It is suggested that you used this control to display 

simple HTML content, rather than rely on full browser capabilities - future version of the GUI runtime 

may use a different implementation which may not have all the capabilities of Internet Explorer. 

The HTML Viewer control has a Value (GPVALUE) property which contains the URL you wish to display in 

the control, as well as a Content (GPCONTENT) property which allows you to load HTML-formatted 

content for display in the control. The control will fire a Click (GECLICK) event if the user clicks a "topic" 

link. You can use this event to reload the Content based on the target topic. 

For more information, see the ATGUIHELP topic in the online help. 

 

Status Bar 

ATGUICREATESTATUSBAR(APPID, FORMID, CTLID, STYLE, ITEMS, GUIERRORS, GUISTATE) 

The ATGUICREATESTATUSBAR routine creates a status bar that displays at the bottom edge of a form. A 

status bar consists of a series of one or more panels and is typically used to display the current status of 

the form, indicating various status information. Each "panel" is described by a value in the ITEMS 

argument as follows: 

 item<1,1,1> =status bar panel ID 

 item<1,1,2> =unused (must be null) 

 item<1,1,3> = panel caption 

 item<1,1,4> = panel icon (picture filename) 

 item<1,1,5> = enabled 



 item<1,1,6> = visible 

 item<1,1,7> = unused (must be null) 

item<1,1,8> = unused (must be null) 

item<1,1,9> = tooltip 

item<1,1,10> = panel size (0=auto, -1=spring, else actual size)  

item<1,1,11> = panel alignment (0=left, 1=right, 2=center) 

 

Note: when a panel size is set to -1 (spring), the panel size is adjusted to fill up the remaining space on 

the status bar. If multiple panels are set to "spring", the extra space is divided among them. 

 

The status bar supports Click (GECLICK), DoubleClick (GEDBLCLICK) and Context (GECONTEXT) events. 

Panels using built-in IDs do not respond to the Click event (*Caps, *Num, *Scroll, *Date, *Time, 

*Timedate).  

 

 

Enhanced Controls 
 

Form 

 drop (drag not supported) 

 

 

Label 

 transparent background (GPTRANSPARENT) 

 FontUnderline (GPFONTUNDERLINE) 

 data field style (2=single line data field, 3=multi-line data field) eliminates need to use '&&' 

when you need to display the '&' character in a label 

 drag & drop 

 

 

Edit 

 New Style property: 0 = single-line, 1=multiline (word-wrap enabled), 2=password, 3=multiline 

(word-wrap disabled), 4 = up/down button 

 FontUnderline (GPFONTUNDERLINE) 

 drag & drop (source and/or target character position is reported in GEDRAGDROP event) 

 SelRange property returns SelStart in propval<1,1> and SelLength in propval<1,2> 

(GPSELRANGE) 

 The edit control GECHANGE event now includes the new content in GUIARGS<1> 

The new style 3 multiline with word-wrap disabled displays both horizontal and vertical scroll bars. 

The new style 4 up/down buttons is a single-line edit control, with a small "spinner" button at the right 

edge. Clicking the up or down spinner button will fire a GEBTNCLICK event, with GUIARGS<1,1> = 0 when 



the "down" button is clicked and GUIARGS<1,1> = 1 when the "up" button is clicked. GUIARGS<1,2> 

contains the current value. 

 

 

Command Button 

 new Toolbar button style (does not get focus) 

 change to Cancel button style - the Cancel button bypasses "required" & local data type 

checking. 

 Icon, IconSize & IconAlign properties display proper icon on button (GPICON, GPICONSIZE, 

GPICONALIGN) 

 FontUnderline (GPFONTUNDERLINE) 

 custom Background & Foreground colors are now supported 

 now supports Border (GPBORDER) property: 0=none for borderless graphical buttons and 

2=normal border. Default is 2. When using borderless graphical buttons, pictures with transparency (for 

example, PNG format with alpha channel) is now supported. 

 drag & drop 

The command button has a new event, GESTATUS, which is fired when a mouse button is pressed or 

released. In this way, an application can perform some action while the button is held down, perhaps 

incrementing some value at a periodic rate. The GESTATUS event arguments are: 

GUIARGS<1,1,1> = button (1 = left, 2 = right, 3 = middle) 

GUIARGS<1,1,2> = state of  Shift, Ctrl & Alt keys 

GUIARGS<1,1,3> = 1 if button is down (pressed), 0 if button is up (released) 

GUIARGS<1,1,4> = X position of mouse, relative to the command button's position 

GUIARGS<1,1,5> = Y position of mouse, relative to the command button's position 

 

 

Option 

 transparent background (GPTRANSPARENT) 

 FontUnderline (GPFONTUNDERLINE) 

 ReadOnly property supported (GPREADONLY) 

 drag & drop (source and/or target button index is reported in GEDRAGDROP event) 

 

 

Checkbox 

 transparent background (GPTRANSPARENT) 

 left (0) or right (1) alignment (GPALIGN) 

 FontUnderline (GPFONTUNDERLINE) 

 ReadOnly property supported (GPREADONLY) 

 drag & drop (GPDRAGID, GPDROPIDS) 

 

 

List box 



 new "checkbox" style supports multi-select using checkboxes instead of ctrl+click 

 New Style property: 0 = single selection, 1=multiple selection, 2= drop-down list, 3=checked 

multiple selection (GPSTYLE) 

 first column can display an icon per-item (GPICON) 

 FontUnderline (GPFONTUNDERLINE) 

 ReadOnly property supported (GPREADONLY) 

 new ColDataType property used to indicate data type when sorting content using ATGUISORT 

(GPCOLDATATYPE) 

 drag & drop 

 new search algorithm: using the keyboard to search a list for a particular item is now consistent 

between the list box, combo box and grid (dropdown list & dropdown combo columns). Previously, the 

grid employed an incremental search and the list and combo box employed a simple first-letter search. 

The incremental search is more powerful: each key typed is concatenated to a hidden string that is used 

to search the list. When a key causes the hidden string to not match any items, the string is reset to the 

last key entered and the search is repeated. For example, if a list contains items 'car', 'cat' and 'dog', 

typing 'c' would select 'car', typing 'a' would keep the same selection. Typing 't' would change the 

selection to 'cat'. Typing 'd' would change the selection to 'dog'.  

 

 

Combo box 

 first column of dropdown list can display an icon per-item (GPICON) 

 return index of selected item using Row (GPROW) property 

 FontUnderline (GPFONTUNDERLINE) 

 ReadOnly property supported (GPREADONLY) 

 new ColDataType property used to indicate data type when sorting content using ATGUISORT 

(GPCOLDATATYPE) 

 drag & drop 

 new search algorithm (see List box above for details) 

 

 

Picture box 

 additional picture file formats are supported: BMP, JPEG, GIF, PCD, PCX, PICT, PNG, PSD, 

TARGA, TIFF, WBMP, XBM, XPM and Windows Metafile 

 drag & drop 

 

 

Frame 

 transparent background (GPTRANSPARENT) 

 added support for caption-less frames, which do not display a caption, and provide slightly more 

space within the frame vertically. This feature is enabled by setting GPSTYLE to 1. A new 

ATGUICREATEFRAME2 subroutine has been added to the library which includes the STYLE argument. 

 FontUnderline (GPFONTUNDERLINE) 



 drag & drop 

 added Click, DblClick, Context events 

 

 

Grid 

 Word wrap (GPWORDWRAP) 

 column-level tab stop overrides default cell navigation (GPCOLTABSTOP) 

 can select, cut, copy & paste multiple cells (GPSELSTART, GPSELLENGTH, GPSELRANGE) 

 new column type displays icon + label 

 new column type, like ellipsis type, displays label + button. Use the GPICON property to set the 

button icon. Clicking the button fires a GEBTNCLICK event. 

 ellipsis column type fires GEBTNCLICK event. This is the same event as GEELLIPSIS (same value in 

ATGUIEQUATES) just a new name. This may cause some confusion in the code generator in the GUI 

Designer. 

 new FocusStyle property (GPFOCUSSTYLE) determines the style of focus indicator used to 

highlight the active cell: 0 = no focus indicator, 1 = thin dotted line, 2 = thick dotted line, 3 = heavy solid 

line. 

 new PasteMode property (GPPASTEMODE) determines whether multi-cell paste is allowed (e.g. 

pasting a block from an Excel worksheet). The default is single-cell paste. 

 FontUnderline (GPFONTUNDERLINE) 

 New DragMode (GPDRAGMODE) property controls grid behavior when dragging within a grid: 

0=change active cell; 1=use drag&drop; 2=extend selection; 3=disable dragging. 

 drag & drop (source and/or target cell position is reported in GEDRAGDROP event) 

 

 

Tab 

 each tab may have an icon (GPICON) 

 FontUnderline (GPFONTUNDERLINE) 

 drag & drop (source and/or target tab index is reported in GEDRAGDROP event) 

 GPDEFVAL is defined to reset the current tab on form Reset. 

  

 

Progress Bar 

 custom foreground & background colors are now supported 

 new "marquee" style displays continuous moving bar for indeterminate progress 

 drag & drop (source and/or target progress bar percent is reported in GEDRAGDROP event) 

 

 

Tree 

 new "checked" style for multi-select tree 



 new "hierarchical checked" style for multi-select tree where checking or un-checking a node 

propagates the node state to all descendent nodes. Changing the state of a descendent node may cause 

ancestor nodes to indicate a mixed state (grayed check). 

 FontUnderline (GPFONTUNDERLINE) 

 drag & drop (source and/or target node path is reported in GEDRAGDROP event) 

 

Other Enhancements 
 

Drag & Drop - most controls now support DragID and DropIDs properties. Any control with a DragID can 

initiate a drag-and-drop operation. As the control is dragged over other controls, the target control's 

DropIDs is searched for an entry that matches the source control's DragID. If a match is found, the 

cursor is changed to indicate that dropping is permitted. Otherwise the cursor indicates that dropping is 

prohibited. When the source is dropped over a matching target control, the GEDRAGDROP event is fired. 

The event is fired on the target control, and the event argument can be queried for the ID of the source 

control. Other information may be passed in the event arguments, such as the source and/or target tree 

node, grid cell, character position (edit & combo box controls), list index, etc.  

 

ATGUISORT - sorts items in grid, list box or combo box 

ATGUICOPY - same as *Copy built-in menu ID 

ATGUICUT - same as *Cut built-in menu ID 

ATGUIPASTE - same as *Paste built-in menu ID 

Tab Stop property now available in the designer 

Pressing the "Application" key on the keyboard will cause a Context (GECONTEXT) event on most 

controls 

 

wED Editor 

The wED editor now has the same tabbed interface style as the main AccuTerm program. Each open 

document is referenced by a tab. The drop-down arrow at the right of the tab bar can be used to select 

any tab. 

A new monospaced font, DejaVu Sans Mono, is now the default font for wED. This is an open source 

font with decent Unicode coverage and nice rendering at most sizes. 

 

User-defined keywords have enhanced block start/end/mid designations, so some of the newer BASIC 

syntax should be easier to recognize. Keywords may contain most characters, including the comment 

characters * and ! as well as spaces. Reserved characters are parentheses, comma and semicolon. 

Allowing the use of comments as keywords might prove useful in conjunction with the code block 



collapsing feature , or when using a pre-compiler. For example, you could define comments like *<<IF>> 

and *<<END>> as keywords and designate them as “block start” and “block end”. Then the code 

collapse feature could hide or show whole sections of code enclosed within these special comments.  

 

The Comment/Uncomment commands now respect the "indent comments" preferences set in the 

editor options. 

 

The wED editor now supports bookmarks. Bookmarks are indicated by a small blue rectangle to the right 

of the line number. Use Ctrl+F2 to toggle the bookmark on the current line, F2 to locate the next 

bookmark in the current document or Shift+F2 to locate the previous bookmark. Bookmarks may also be 

toggled using the context (right-click) menu. 

 

The Search function has been enhanced to include an option to search all open documents. Multiple 

results can be bookmarked or shown in the Results window. 

 

Forward and backward navigation is now supported. Use the arrow icons on the toolbar, or Alt+Left to 

navigate backward or Alt+Right to navigate forward. Navigation is maintained across multiple 

documents. 

 

Code block collapsing is supported for recognized syntactical blocks (IF-THEN-ELSE, FOR-NEXT, BEGIN 

CASE-END CASE, LOOP-WHILE-REPEAT). This function must be enabled in the General preferences (Tools 

-> Settings -> General). 

 

A wED configuration record on the host can be used to specify keyword lists, compiler command and 

format preferences, allowing these settings to be easily shared among developers. wED configuration 

settings are stored in an item named 'WED' in the ACCUERMCTRL file. The layout of the WED item is: 

1. must be ‘X’ 

2. file name and item ID of the language keyword list - the file name and ID are separated by a 

backslash character 

3. file name and item ID of the user keyword list, using a backslash to separate the file name and 

ID 

4. command to execute to compile a program. The command line must contain tokens 

%FILENAME% and %ITEMID% which are substituted before the command is issued. For example: 

COMPILE %FILENAME% %ITEMID%.  

5. comma-separated list of indent values: Margin, Tab Size, Indent for Star comments, Indent for 

Bang comments. Margin & Tab Size are characters; Indent for Star & Indent for Bang are 0 

(margin), 1 (code) or 2 (none).  

Any lines that are null use the default values for those lines. To initialize the keyword list, use the Export 

button on the Language or User keyword tab in the Settings dialog. The keyword list is a simple text 

item, one keyword per line. Each keyword may have a suffix character to indicate its effect on the block 



structure of the BASIC language. The block structure suffixes are used by the formatter and by the block 

collapse function to identify block structures in the program being edited. The suffix characters are: 

+   keyword indicates the beginning of a block structure (for example, FOR in a FOR … NEXT 

structure) 

-   keyword indicates the end of block structure (for example, END in a multi-line IF … THEN … 

END structure) 

=   keyword indicates a mid-block (for example WHILE, in a LOOP … REPEAT structure) 

[   keyword indicates the beginning of a block structure when found at the beginning of a line 

]   keyword indicates the beginning of a block structure when found at the end of a line 

The keyword list may contain comment lines which begin with a semicolon (;). You can use comments to 

identify special keyword lists, or for other documentary purposes. Two special comments are recognized 

when the keyword list is accessed by wED: 

;CASE SENSITIVE 

;CASE INSENSITIVE 

These comments indicate if the keywords in the list are case sensitive or not. Note: the case sensitive 

setting is global and affects both the language and user keywords. 

Keyword lists for several MultiValue platforms are available on the PickWiki site. Check out 

www.pickwiki.com and search for AccuTerm and you’ll find the topic.  

http://www.pickwiki.com/


AccuTerm 7 Update History 

Beginning with release 7.1c, AccuTerm is a Zumasys product. This is reflected in updated graphics, 

copyright, trademark and license agreements. 

 

Release 7.1c-sp2 (06-08-2016) 

The following new features have been added (main program):  

1) Added new McDonnell Information Systems Prism 8 emulation. 

 

The following bugs have been fixed (main program):  

1) Fixed SSH bug where only first prompt during keyboard-interactive authentication was being 

displayed. Other prompts were hidden. 

2) Fixed SSH buffer overflow bug when using very long banner messages. 

3) Fixed bug affecting export and import of date and numeric values to/from Excel when Excel is using 

non-US date or number formats. 

4) Fixed bug causing certain UTF-8 characters to be corrupted when used with GUI or wED Editor. 

5) Fixed problem where ScrollLock key would lock a session, but pressing key again would not unlock it. 

6) Fixed problem where Ctrl+F1 … Ctrl+F6 were not sending F11 … F16 function key sequences when 

this option was selected in the session Keyboard settings. 

7) Fixed problem with “Backspace sends DEL” option in Terminal settings where the opposite character 

was shown in the Keyboard Programming for the backspace key. 

8) Fixed problem with capture of printed data. 

9) Fixed screen print bug when using a print adapter. Temporary file was stored in Unicode (without a 

BOM) even though encoding was set to “none”. 

10) Fixed phone.dat file corruption when updating or deleting an entry from the dialer directory. 

11) Fixed sound problem when playing multiple sound files in rapid succession. 

12) Fixed incorrect main window size saved in a layout when window was “snapped” to full screen 

height (but not maximized). 

 

Host program bug fixes and enhancements: 

1) Changed handling of column headings from file dictionary so that value marks are now converted to 

blanks. 

2) Fixed problem exporting from jBASE dictionary items with A/F correlative in line 8 and any other 

conversion code in line 7. 

 

The following GUI bugs have been fixed: 



1) Fixed problem with typeahead losing data when using a barcode scanner to enter data rapidly into 

several fields in succession. 

 

The following wED Editor bugs have been fixed: 

1) When performing a case-insensitive search, only the US-ASCII characters were properly matched. 

International characters were not compared in a case-insensitive manner. This has been fixed so 

that international characters are properly compared. 

 

 

Release 7.1c-sp1 (09-24-2015) 

 

The following bugs have been fixed (main program): 

1) Fixed problem printing in "text mode" on Windows 8.1 & Windows 10. 

2) Fixed compatibility problem with OpenSSH release 6.8 causing connections to close immediately. 

3) VT commands to erase a rectangle (DECERA & DECSERA) now fill the rectangle using the NORMAL 

attribute instead of the current attribute. 

4) Fixed problem with Wyse 50 & Viewpoint A2 Enhanced emulations where updating the last column of 

the screen with an embedded attribute did not propagate the attribute to the end of the screen (or the 

next embedded attribute). 

5) Fixed problem with Wyse & ADDS emulations where underline or blink tag attributes were not 

processed correctly (when "allow blink" and "allow underline" settings were enabled). 

6) Fixed problem with how Ctrl+Backspace key was handled. This key combination now sends the DEL 

control code (delete) instead of an underscore character (_). 

7) Fixed custom window title problem which caused the title to revert back to "AccuTerm 7"instead of 

the custom title when switching to a different session. 

8) Improved CapsLock key tracking. With this option is enabled, when a session is activated, the state of 

the CaspsLock key should be restored to the same state as when the session was last used. 

 

Host program bug fixes and enhancements: 



1) Fixed problem with Northgate Reality version of host programs, where dictionary items containing 

both correlative & conversion codes were processed incorrectly. 

2) The host programs have been enhanced to support UTF-8 on some platforms lacking native UTF-8 

support (d3). See 'readme.txt' in the PICKBP directory for more information on enabling this feature. 

 

The following wED Editor bugs have been fixed: 

1) The dropdown list for the "Find what" box in the wED search dialog was never populated with recent 

search strings. This is now fixed. 

2) The wED editor now supports item IDs with embedded commas or semicolons. 

 

The following AccuTerm Cloud bugs have been fixed: 

1) When a text screen was displayed on a web page in Internet Explorer using the AccuTerm Cloud plug-

in, sometimes the text cursor would disappear. This has been fixed. 

2) When creating a new AccuTerm Cloud connection using the Connection Designer, the boiler-plate 

HTML has been updated to include new messages alerting the user about unsupported browsers and 

platforms. This is accomplished with some Javascript that is now included at the end of the HTML file. 

 

Release 7.1c (11-07-2014) 

The following bugs have been fixed (main program): 

1) Fixed Wyse character set bug when using a codepage for the host character set. 

2) Fixed problem where half of a double-wide character at end of line would not get cleared. 

3) Fixed data corruption problem with the modem dialer phone book file. 

4) Fixed problem with redirected printer names on Citrix & Terminal Server. 

5) Fixed alignment problem with images displayed on the screen and then printed. 

6) Fixed background screen image problem where using a URL instead of a file path would fail. 

 

Release 7.1b-sp2 (06-18-2014) 

The following bugs have been fixed (main program): 



1) Fixed bug that caused SSH connection to terminate when an unexpected message was received 

before the host shell process was started, for example ‘password expired’. 

2) Fixed SSH annoyance where an incorrect password caused a disconnect after re-entering the user ID. 

Changed to allow up to 3 attempts before disconnect, as long as the same user ID is entered each time. 

3) Fixed capture append bug when appending text-only files. 

4) Fixed problem with screen-prints when screen contains double-high or double-wide characters. 

5) Fixed screen printer bug where selecting the default printer for screen printer but disabling slave 

printing would cause screen printer to be disabled as well. 

6) Fixed problem with relative paths to My Documents were not resolved correctly. 

7) Added new ‘Init’ function to AccuTerm Internet Edition connection script. The Init function is called 

before the connection is opened. 

 

The following GUI bugs have been fixed: 

1) Fixed activation bug in forms that have a browser control. 

2) Fixed “flashing window” bug where main AccuTerm window title bar and taskbar icon would flash 

several times if a GUI form was hidden, then another GUI form was immediately shown. 

3) Fixed problem with ColDataType property not being handled in the designer for List & Combo 

controls. 

4) Fixed bug in ATGUISORT for List & Combo controls only sorting on the first column specified. 

5) Added new WindowHandle property (GPWINDOWHANDLE) to root, app and form objects. This 

property might be useful for some advanced scenarios. 

6) Added support for the Border property (GPBORDER) to command buttons. Valid values are 2 = normal 

border (the default), and 0 = borderless. Graphical buttons are now possible by using pictures with 

borderless buttons. Pictures with transparency, such as PNG files with alpha channel, are now supported 

for borderless buttons.  

7) Fixed “data execution prevention” bug in the Grid control when using boot configuration option nx 

set to AlwaysOn. 

8) Settings for project default font name & font size were being ignored. Now they are used as the initial 

font properties for newly created forms. 



9) Beginning with AccuTerm 7, the default font was changed from “MS Sans Serif” to “Arial”. This 

worked properly in the GUI Designer, but at run time, “MS Sans Serif” was still being used as the default 

font. Now, “Arial” will be used as the runtime default as well. 

 

 

Release 7.1b-sp1 (02-10-2014) 

The following changes have been to the SSH protocol: 

1) Added CTR-mode support for AES 128 & 256 bit ciphers . 

2) Changed default cipher for SSH2 connections from Triple DES to AES 128 in CTR-mode. 

3) AES CTR-mode ciphers have priority over CBC-mode ciphers during negotiations. 

 

The following bugs have been fixed (main program): 

1) Fixed text-mode capture problem in VT emulation which caused extra tab characters to be written in 

the capture file. 

2) Fixed problem with keyboard in Wyse/ADDS emulation when line-drawing character set is selected. 

3) Fixed VT100 emulation bug where the line-drawing character set could not be selected  unless the 

session was configured to use the “DEC Multinational” character set. 

4) Fixed Euro character code setting (was being ignored since release 7.0). 

5) Fixed problem with permissions for custom shortcuts when performing a customized installation. 

 

The following GUI bugs have been fixed: 

1) Fixed problem using multiple monitors where reported position of maximized window on secondary 

monitor was incorrect. 

2) Fixed problem with excessive number of GDI objects when a menu used many icons. 

3) Fixed printer dialog (ATGUIPRINT2) where number of copies was being ignored. 

4) Fixed problem when using a multi-line description or copyright in the app properties in GED. 

5) Fixed problem opening the code window (WED) from the GUI designer under Windows 8. 



6) Fixed a Windows 8.1 typeahead problem which caused wrong (or no) event to fire when clicking a 

control while a context menu is displayed. 

 

 

Release 7.1b (10-11-2013) 

The following bugs have been fixed (main program): 

1) Added new connection method: SSL/Telnet. 

2) Added host key verification to SSH. 

3) Updated SSH crypto functions for Windows 8.1 compatibility. 

4) Zmodem uploads no longer force the file name to be lower-case. 

5) The AccuTerm escape sequence to draw a border around a rectangle was not drawing the entire 

border.  

6) When using multiple screen pages, switching between normal and extended mode might cause the 

screen to become corrupted if normal and extended modes have different number of rows. 

7) Sometimes the current directory was used instead of the default directory when loading a script file 

that did not include a full path. 

8) In the wED Editor, the Replace function did not always handle “match case” correctly. 

9) WED, GED and FTWIZ did not correctly parse item-IDs enclosed in double quotes with embedded 

spaces in the ID, from a TCL command line. 

10) The file transfer wizard now supports the option to use column headings instead of dictionary names 

when exporting data files to Excel or delimited text files (this feature was previously supported by the 

FTD utility and FTEXPORT subroutine, but not by the wizard). 

11) Bug in file transfer wizard caused the header row of a text file to be included as data when importing 

to a host file was fixed. 

12) Fixed bug in file transfer wizard which allowed associated PC file names and MV Item IDs to get out 

of sync, when renaming files during the transfer. 

13) During installation, Custom Feature Codes were being ignored. 

14) During installation using a setup.ini file, the DESKTOPSHORTCUT = N option was not working. 

15) The “Update MultiValue Host Programs” script has been modified to re-install the FTBP file first. 



16) The FT, FTD and FTPICK programs now support an optional user-defined exit string. Entering the 

specified exit string at any prompt in one of these programs immediately terminates the program. Use 

FTSETUP to specify the exit string. 

 

GUI Enhancements and Fixes: 

 

1) The ATGUISORT subroutine, when sorting multiple grid columns, only sorted on the first column 

specified. Now all the columns in the list are used for sorting. 

2) Fixed bug with tool tips on toolbar buttons and status bar panels. The bug caused ampersand 

characters (&) used in tool tip text to be discarded.  Note: according to Microsoft developer 

documentation, status bar tool tips are displayed only if the panel has an icon and no text, or if all of the 

text cannot be displayed inside the panel. 

3) Fixed bug in read-only combo box. Setting the Value property of a read-only combo box updated the 

selection in the item list, but did not display the selected item. Now the display matches the selection, 

even if a combo box is read-only. 

4) Fixed bug in Timer control where events were fired even if the form containing the timer was 

disabled. Timer events will no longer occur if the timer’s form (or other container) is disabled. 

5) Fixed bug which sometimes would place an inactive form above the active form. The inactive form 

may not be enabled. This usually would occur when the main AccuTerm window as the active process, 

and the user clicked somewhere on a GUI form to activate the GUI form. The clicked-on form would 

become the active GUI form, but sometimes a different form would display above the active form. 

6) Fixed a problem where a form’s initial position appears to be random when using a thin client or 

remote desktop on Terminal Server. 

7) Changed ATGUIVERSION constant in ATGUIEQUATES from a number to a string for compatibility with 

D3 using European number format. 

 

Release 7.1a-sp2 (04-09-2013) 

The following bugs have been fixed (main program): 

1) Fixed macro recorder issue crashing program when recording macro opening multiple sessions.  

2) Fixed macro recorder problem with recording of HostPort and Palette properties. 

3) Fixed relative path for ssh private key file name in .atcf file. 

4) Fixed incorrect character set bug in slave printing “copy print” or “auto print” mode. 



5) Fixed crash when using print adapter and host character set is UTF-8. 

6) Updated adapter scripts for Print Wizard version 4.1. 

7) Updated components for .Net compatibility. 

 

Release 7.1a-sp1 (02-25-2013) 

The following bugs have been fixed (main program): 

1) Fixed problem with “insert character” or “insert mode” in all emulations. 

2) Fixed buffering problem which caused data corruption when reading large records using WED & GED. 

This problem is limited to AIX-based host database environments. 

3) Fixed problem that caused Zmodem file transfers over SSH to fail. 

4) Fixed cosmetic issue with file transfer status window showing “0 bytes” at completion of a transfer 

job. 

5) Fixed file transfer problem when a UNC path to a share is used as the target directory. The problem 

only applies to the top-level share directory – subdirectories are not affected. 

6) Fixed problem when using non-standard key length for DSA host keys in SSH. 

7) Fixed problem with multiple file selection for file upload. 

 

The following GUI bugs have been fixed: 

1) Fixed problem with multi-select tree control with multiple top-level nodes not returning correct value. 

Trees with a single root node worked properly. 

2) Fixed problem when using a timer control, when a system dialog was open (MsgBox, Font dialog, etc.) 

the Timer event would cause the GUI to freeze. 

3) Fixed problem with StatusBar control with hidden panels returning incorrect panel ID in Click, DblClick 

& Context events if any hidden panels precede the clicked panel. 

4) Fixed problem with multiple file selection in ATGUIFILEDIALOG. 

5) Fixed freeze in ATGUIFILEDIALOG when opened from Click event by pressing ENTER on a command 

button which has focus. 

 



The following wED Editor bugs have been fixed: 

1) Fixed problem with multiple search results not activating the correct document when double-clicking 

a line in the results window. 

2) Fixed “Find All” & “Replace All” when search scope is “selected text” so that the selection is restored 

after the search / replace operation. 

3) Fixed problem when search result is inside of a collapsed block. The block is now automatically 

expanded so the search result is visible. 

4) When the cursor is at the top of the document and the Find dialog is opened, the first word in the 

document is not automatically loaded in the “Find what” field. Normal behavior is to load the word at 

the cursor into the “Find what” field as long as the cursor is before or within a “word”. 

5) When using “Replace Next”, after the last match is replaced, the “text not found” message was not 

being displayed until “Find Next” was clicked. The message not displays after the last replace operation. 

 

Release 7.1a (12-19-2012) 

The following bugs have been fixed (main program): 

1) Fixed Excel export bug when specifying a target worksheet name on a new workbook. The blank 

“sheet 1” tab is no longer included in the new workbook. 

2) Fixed Excel 2013 export “select failed” error. 

3) Fixed the Reset function in the keyboard editor. 

 

The following GUI bugs have been fixed: 

1) Fixed designer so that labels are aligned the same at design time as they are at run time. Previously, 

the designer showed labels a few pixels higher than they were shown at run time. 

2) Fixed problem where clicking a command button twice quickly would buffer the second click when 

the first click caused a modal dialog to be shown. In this case, the second click should have been 

discarded. 

3) Fixed command button TabStop property so that buttons with the “toolbar” style ignore this property 

(toolbar style buttons do not support tabbing). 

4) Fixed bug that ignored setting the PrinterName property of the global Printer object. 



5) Fixed Move method so that when NULL is passed for the Left or Top argument, the current value is 

used. 

6) Fixed menu bug where enabling a disabled top-level menu was not enabling the sub-menu items. 

7) Changed the argument used to specify the number of properties in ATGUIGETPROPS & 

ATGUISETPROPS. Used to be DCOUNT(CTLIDS,AM), now  DCOUNT(PROPS,AM). This allows passing NULL 

for CTLIDS when setting multiple properties on a form or app object. 

 

The following wED Editor bugs have been fixed: 

1) Fixed parsing of multi-line On Go… statement. 

 

Release 7.0d-sp2 (05-11-2012) 

The following bugs have been fixed (main program): 

1) Fixed bug when opening certain layout files where the active window did not have the focus. 

2) Fixed problem with incorrect terminal screen size when using very high resolution monitors. 

3) Fixed typo in warning message in activation dialog. 

4) Fixed potential buffer overrun problem when attempting to use a corrupt ssh key file. 

 

The following GUI bugs have been fixed: 

1) Fixed typeahead problem with modal dialogs (ATGUIMSGBOX) freezing when using Alt+key shortcut 

to close the dialog. 

2) Fixed bug with Grid printing when number of fixed columns is same as total columns. 

3) Fixed bug where MDI background picture was not refreshed after resizing the parent widnow. 

4) Fixed bug in designer where Word Wrap checkbox was sometimes hidden for grid controls. 

 

The following wED Editor bugs have been fixed: 

 

1) Fixed problem with item lock not being released when update is cancelled. 

2) Added asterisk after file name in window title if document has been modified. 

 



 

Release 7.0d-sp1 (09-13-2011) 

The following bugs have been fixed (main program): 

 

1) Changed the way the list of installed printers is created to make it more reliable. 

2) Changed the way images displayed on the text screen are scaled to improve image quality.  

 

The following GUI bugs have been fixed: 

1) Fixed a bug in the MDI Tab Bar that allowed the “X” to close a disabled form. 

2) Changed the way images are scaled to improve quality. 

3) Fixed a tab order inconsistency in the designer. 

4) Fixed problem that changed the style of a dropdown list to a combo box if the list ReadOnly property 

was set, then reset. 

5) Fixed problem that restored a form immediately after minimizing, when the main AccuTerm window 

was minimized. 

 

Release 7.0d (06-20-2011) 

The following bugs have been fixed (all programs): 

 

1) An error was discovered in a component DLL which is used in nearly every part of AccuTerm. The 

error prevented some kinds of cleanup from occurring when closing a program. No specific bugs have 

been attributed to this error, however, for correctness, it has now been fixed. 

 

The following bugs have been fixed (main program): 

 

1) When installed using "portable" or "standalone" mode, the WED Editor and GUI Designer would hang 

when launched. This was due to a missing type library which has now been added.  

 

2) When installed using "portable" or "standalone" mode, sometime the temporary registry entries were 

not cleaned up when the program closed. 

 

3) If the path for a non-existent directory was entered as the "home directory" during install, at run-

time, the home directory would be set to the program directory. Now, if the directory does not exist, 

when AccuTerm is first run, it will attempt to create the directory and if successful, use the specified 



directory.  

 

4) The "new connection" wizard now saves the telnet port and SSH port separately. Previously a single 

port number was saved between executions of the wizard, and the previous value was used as the 

default the next time the wizard was executed. If the next execution created a session using a different 

protocol from the previous execution, the wrong port would be shown as the default. 

 

5) The Upload and Download dialogs now save the file transfer protocol selected and use this as the 

initial selection next time the dialog is opened. 

 

The following scripting bugs have been fixed: 

 

1) The default value for the Right & Bottom arguments of the Session.Select and Session.SetSelection 

functions has been changed from -1 to -32768. This was done so that these functions could be used to 

select text in the screen history, which is referenced using a negative value for the row number. 

Previously, any negative number was treated as "last column" or "last row". 

 

2) The Item property of the FKey object was assigned as the object's "default" property. This fixed an 

incompatibility with the GET.PROGRAMMED.KEYS subroutine. 

 

3) The Settings.Dialog() function was not properly displaying nodes in the tree for specific panels when 

the Categories argument was used to limit which panels should be available in the settings tree. 

 

The following GUI bugs have been fixed: 

 

1) The Context event for Option controls was not firing. This has been fixed. 

 

2) The Required property for Option, List (single-select & drop-down) controls was being ignored. This 

has been fixed. 

 

3) When using MDI applications, selecting a child form by clicking on the MDI tab would corrupt the MDI 

child window z-order. This has been corrected. 

 

4) A bug in the GUI typeahead function allowed mouse & keyboard events saved in the typeahead buffer 

to be processed just before a system dialog was displayed (message box, printer setup, font selection, 

etc.). This could cause a variety of odd behaviors such as the wrong form being activated. Now the 

typeahead is cleared before showing a system dialog, just like calling ATGUIACTIVATE clears the 

typeahead. 

 

5) Fixed problem with Option controls which allowed the cursor keys to change the selection when the 



ReadOnly property is set to True. 

 

The following wED Editor bugs have been fixed: 

 

1) Sometimes, after doing a Format operation, the Enter key would not function until the cursor keys 

were used to move the current location. 

 

2) When a new item is created using the WED verb from TCL, the Compile tool was disabled until a File-

>Save was performed. Now the Compile tool is enabled and you will be prompted to save before 

compiling. 

 

 

Release 7.0c (03-02-2011) 

The following new features have been added (main program): 

 

1) The installer recognizes a new "AUTOUPGRADE" item in the SETUP.INI file to control automatic 

migration of preferences and files from an earlier version of AccuTerm. When this item is specified, the 

"AccuTerm 7 Upgrade" dialog is suppressed when AccuTerm 7 is first used and an earlier version of 

AccuTerm is detected. See the help file, AccuTerm 7 Reference chapter, for more details.  

 

2) A new subroutine, FTEXPORTDA, has been added to the FTBP file transfer library. This subroutine 

works similarly to FTEXPORT, except that instead of the source data being read from a file, it is passed as 

an argument to the subroutine as a standard dynamic array. 

 

3) The wED editor now has an option to show Min/Max/Close buttons on the document window title 

bar. By default these buttons are not shown as they sometimes do not play nicely with the new tabbed 

interface.  

 

4) The Close button for the Session Tabs (and Document Tabs in wED) has been moved from the right 

edge of the bar to the right edge of the tab for which the close action applies. 

 

5) The command-line parser for the WED, GED and FTWIZ verbs has been enhanced to perform simple 

upper-case conversion for those platforms that normally have this feature (QM & mvBase). On these 

platforms, if you enter a command entirely in lower-case, and the file exists in the MD / VOC only as 

upper-case, the entire command is converted to upper-case before processing. 

 

The following bugs have been fixed (main program): 

 



1)Fixed menu Help->Documentation so that it now opens the selected document (it used to simply do 

nothing).  

 

2) The "AccuTerm 7 Upgrade" process for converting customized menus from previous versions of 

AccuTerm now works more reliably and accurately. 

 

3) File transfers to Excel (FTD, FTEXPORT, File Transfer Wizard) where a column contained both string 

and numeric (or string and date) data, the column was "auto-sized" based only on the string data. If the 

column contained only short strings, it might not be sized correctly to display the numeric or date 

values.  

 

4) Fixed Page Setup so that the printer orientation works. Also fixed problem causing paper bin and 

paper size drop-down lists to be empty.  

 

5) Fixed session tab context menu so that if the main menu File->Close item is disabled, the Close item in 

the context menu is also disabled. 

 

6) In the WED Editor, documents are always saved using standard Windows line ending of CR/LF. 

Previously, if a document using only LF or only CR for newlines was saved to the host, the CR or LF 

control characters were stored in the host record instead of converting to AM. This was because the in 

transmission to the host, CR/LF were converted to AM, but not CR or LF by itself. 

 

The following new features have been added to the GUI: 

 

1) New toolbar styles allow a toolbar button to display both an icon and caption. The new styles are 2 

(small icon with caption) and 3 (large icon with caption).  

 

The following GUI bugs have been fixed: 

 

1) When creating controls at runtime (on the fly) on a visible form, the controls were initially created 

using a pre-defined location and size and then moved. The problem is that controls initially are visible, 

and this caused a noticeable flicker. This has been fixed. 

2) When using icons and pictures from a web server, if a URL was used more than once, all but the first 

time, the resulting image was blank. This has been fixed.  

 

3) Fixed a timing issue when images from a web server are being used for grid items or list items. Images 

from a URL are downloaded asynchronously, and if target row of a icon in a grid or list were to move 

(insert or delete rows before the target row) before the image was available from the server, it could get 

stored in the wrong item. This has been fixed. 

 



4) In the HTML Viewer control, setting the Content property more than once failed on all but the first 

time, and the Reset command was ignored. This has been fixed. 

 

5) Combo box and single-line edit controls allowed multi-line data to be pasted from the clipboard. Now, 

only the first line of multi-line data is pasted. 

 

6) When copying data to the clipboard from a grid cell with selected text, the entire cell content was 

copied instead on only the current selection. Now only the selection is copied. 

 

7) When pasting into a grid cell, sometimes the grid status was not marked as "changed". 

 

8) When using MDI applications, if a control on an MDI child form as focus, and a non-MDI form (dialog 

form) is shown / activated, when the original MDI child form is re-activated, the focus would advance to 

the next control on the form. This has been fixed. 

 

9) Fixed a refresh problem with dropdown lists using border style of Flat or None.  

 

10) Fixed a problem with the MDI tab bar where a tab would not appear when a new child window is 

first created. Switching to a different child window and back to the problem window caused the tab to 

appear. 

 

11) Fixed a small window in the typeahead logic where an event would be queued for transmission to 

the host, but typeahead would not capture keyboard and mouse events until the transmission was 

initiated. With very quick fingers it was sometimes possible for keyboard and/or mouse actions to alter 

the state of a control. This new state would not be reflected in the event already queued, so the host 

program might get out of sync with the actual runtime state. 

 

12) When the height of a Tab control was very small, an "Invalid procedure call" error was returned. This 

has been fixed. 

 

13) Setting the Foreground color of a Frame control at run time sometimes ignored the change until the 

form was refreshed. This has been fixed. 

 

14). Disabling a frame during a List box Activate event may cause the Click event for the list to be lost. 

This has been fixed. 

 

Release 7.0b (08-26-2010) 

The following new features have been added (main program): 

 

1)When the function bar is displayed, the bank selection (leftmost button in the function key button bar) 



now includes a new choice: Auto. When Auto is selected, the function key bar tracks the state of the 

Shift and Ctrl keys. Other selections (Normal, Shift, Ctrl, Shift+Ctrl) lock the bar to the designated bank. 

 

2) The "reconnect" panel that is displayed when a connection is lost has a new "Info" button. Clicking 

this button will display additional information related to the cause of the disconnect (a popup help 

topic). Similarly, the connection error dialog that pops up when a network or communication error 

occurs also includes an "Info" button to display additional information about the error. 

 

3) The character set selected in the Settings dialog is now used as the "User Preferred Supplemental Set" 

(UPSS) when running the VT220, 320 & 420 emulations. Similarly it determines the international 

character set used in Prism P30 emulation. 

 

4) The wED editor now has a Maximize menu item in the Window menu to maximize the current 

document. 

 

5) The Session object now includes AnsiAutoPrint and CharacterMapping properties. These were 

previously available only as properties of the Settings object. 

 

The following bugs have been fixed (main program): 

 

1) On systems using multiple monitors, any tree control (settings dialog, GUI designer, GUI program 

using a tree, etc.) placed on a monitor which is to the left of the primary monitor (the one with the Start 

menu) would not respond to mouse clicks. 

 

2) When using Viewpoint Enhanced emulation with a screen background picture, the picture was not 

visible when using the ADDS 4000 style "normal" visual attribute. The picture should be visible wherever 

the "normal" attribute is displayed. 

 

3) In certain cases where the screen is frequently switched between normal (80 column) and extended 

(132 column) mode, occasionally, when in extended mode, the screen would display blanks in columns 

past the end of the normal screen width. When the problem occurs, it would usually only affect one or 

two lines on the screen. 

 

4) The PrinterName and TitleFormat properties caused an error when used in a recorded macro. 

 

5) A small bug which caused the Host Type field in the Settings dialog to show "custom" instead of the 

selected host type has been fixed. 

6) In the Settings dialog, the list of print adapters may not be properly loaded when starting AccuTerm 7 

from a shortcut that does not use Atwin70 as the startup directory. Also, sometimes the adapter 

selected would not match the one that is used. Finally, there should have been a  tooltip that displays 



the print adapter description for each item in the list when the mouse hovers over any item. These 

problems have been fixed. 

 

7) After changing certain settings to zero (for example, Interline Delay), then saving the session, the 

changed setting would not be saved in the session file. 

 

8) In the main AccuTerm program, using the menu designer, it was not possible to disable the main 

menu. 

 

9) A bug that caused AccuTerm to crash when using [ActiveSession.Close] from a function key was fixed. 

 

10) When opening multiple sessions, especially from a layout file, AccuTerm could get into an infinite 

loop activating and deactivating the newly added session windows. 

 

11) The script used to install the host programs from the MultiValue -> Host Programs menu failed when 

AccuTerm was launched from a shortcut that did not use Atwin70 as the startup directory.  

 

12) The FTSETUP program used by the MultiValue -> Host Programs menu (and from TCL prompt) did 

not update existing catalog items in the MD / VOC when you choose "replace all" from the "item exists" 

prompt. 

 

13) When importing a large number of keywords into wED, the import would fail. 

 

14) In the WED Editor, double-clicking a label on a GOTO or GOSUB statement moves the cursor to the 

line containing the target label. The document should scroll so that the target is in the center of the 

window. Also, some of the WED dialog boxes (Goto, Find, etc.) would not position themselves on the 

same monitor as the main window if the monitor containing the main window was to the LEFT of the 

Start menu (primary monitor). These have been fixed. 

 

15) In the WED Editor, if you have multiple documents open and they are not "maximized", opening a 

new document switches all documents to "maximized". This has been fixed so that a new document will 

open in the same window state (maximized or normal) as the currently active document. 

 

16) In the WED Editor, the code formatter was unable to handle using the LOOP keyword as a variable 

name. This has been partially fixed. However the code formatter is unable to distinguish between LOOP 

as a keyword and variable name if it is the first word in a line. 

 

17) When the Settings dialog is open, pressing the F1 key usually displayed the Contents page from the 

help file instead of the help page for the selected category. 

 

18) When using the keyboard with the connection wizard, pressing Enter to each prompt, the newly 

created session would immediately abort the connection process. This was caused by the Enter key 



being handled first by the Finish button in the wizard, then by the Abort button on the session window. 

This has been fixed by delaying the appearance of the Abort button by a second or two. 

 

19) A custom title did not always work - sometimes the title reverted back to "AccuTerm 7". 

 

20) The "Standalone" installation option would fail unless the user had administrator privileges. This has 

been fixed (one of the main reasons for this installation option is to enable non-admin users to install 

the product for their personal use). 

 

The following new features have been added to the GUI: 

 

1) A minor enhancement / change to the Resize event: when a form is moved by the user, a Resize event 

is now fired, even if the size has not changed. The new position is indicated in GUIARGS<1,4> (left) and 

GUIARGS<1,5> (top). The Resize event is now available to fixed size forms. 

 

The following GUI bugs have been fixed: 

 

1) Several GDI object leaks have been fixed. 

 

2) Under Windows XP only, in the GUI, clicking most controls that have a tooltip would cause the tooltip 

to never display again. Similarly, leaving the mouse over a control with a tooltip until the tip disappeared 

would never display the tip again.  

 

3) The way that SelStart and SelLength in GUI combo boxes has been changed. Setting the SelStart 

property implicitly sets the SelLength property to zero, removing any selection highlight from the text 

part of the combo box. This is the same behavior as the edit control. A bug in the original release of 

AccuTerm 7 caused SelLength to be set to a negative value, causing text from the beginning up to the 

new SelStart position to be selected (if you were to retrieve the SelStart and SelLength properties after 

setting SelStart, SelStart would be zero and SelLength would be the value you had specified for SelStart). 

A bug in the 2K2 version of the combo box caused SelLength to be set to the end of the text selecting 

the text from the SelStart position to the end. 

 

4) In the GUI, the status bar was firing Click, DblClick and Context events whether or not these events 

were selected in the designer. 

 

5) In the GUI, when a grid was placed in a container whose Enabled property was False, changing the 

container's Enabled property to True did not cause the grid to become enabled. 

 

6) When an MDI Child form is first displayed, the first control in the form was not automatically 

activated. 



 

7) In the GUI designer, the Preview function will now work with an MDI app object. 

 

8) In the GUI, when word-wrapping in a grid control is enabled, text in the last column may not be 

wrapped correctly. This is partially fixed. The underlying problem is that the actual size of the last 

column changes as the grid is scrolled horizontally. This is not solvable. However, when the grid displays 

all the columns, the wrapping in the last column should now be correct. 

 

9) Using a Picture control as a container failed for many control types. This was due to the fact that the 

Picture control does not have BackColor, ForeColor or Font properties, and several control types inherit 

these properties from their parent. When the picture control is the parent, these properties will be 

inherited from the Form instead. 

 

10) The GUI runtime maintains a count of visible forms. When any forms are visible, the "this session is 

running a GUI application" message is displayed on the text screen. There were certain sequences of 

functions that corrupted this count. This could cause the text screen to be activated when hiding a GUI 

form while other forms are still visible. This causes a flickering as the text and GUI applications are 

switched, and degrades performance. 

 

11) When using MDI forms, each child form can have its own main menu. When the child form is the 

active form, its main menu replaces the main menu of the MDI parent window. A problem was 

discovered when a new MDI form was being created, before its menu had been initialized, the empty 

child menu replaced the parent menu. Once the child form's menu was initialized, the new child menu 

replaced the empty menu. This caused the child forms to quickly "jump" up and down as new forms 

were created. This is now fixed. 

 

12) When an MDI application has one or more hidden MDI child forms, the tab for the hidden child 

forms is still displayed on the MDI Tab bar. 

 

13) When using the "multiple application model" with MDI subroutines, after all MDI apps had been 

deleted, then after showing a modal dialog, the "host busy" window would appear and there was no 

way to hide it. 

 

14) In the GUI it was possible for the Enabled state of a container control (frame, picture box, tab) to 

become disabled when it should not. 

 

15) Several bugs related to controls placed directly on a Tab Group control have been fixed. These were 

all related to focus problems when activating a control using the mouse. Symptoms ranged from missing 

Validate events, to requiring multiple clicks on command buttons to trigger a Click event. Note: the 

controls must be in the Tab Group; all controls on a Tab behaved correctly. 

 

16) When deleting the only Tab in a Tab Group, any controls that are placed directly on the Tab Group 



become hidden when any Tabs are added to the Tab Group. They actually are not hidden, just obscured 

by the newly added Tabs. 

 

17) When using a non-default font for a List Box control sometimes the vertical scroll bar in the list box 

was incorrect or missing. 

 

18) Several problems in the GUI designer where certain properties were not saved correctly have been 

fixed. 

 

19) When positioning a form using "auto" coordinates, which should center the form in the display area, 

AccuTerm used the actual screen size rather than the usable screen size when calculating the position. 

This could cause the bottom edge of large forms to be obscured by the Windows task bar. 

 

20) Under Windows Vista and Windows 7, the frame of fixed-size forms is the same as for sizable forms. 

This is different behavior than Windows XP. To make this difference "transparent" , Windows reports 

the size smaller than it actually is (Windows Vista & 7 report  lie about the border size and return the 

same value that was returned in XP). This could cause forms positioned at or near zero for the left or top 

coordinate to have their border displayed off-screen, or on the adjacent monitor if using multiple 

monitors. AccuTerm now adjusts for this different behavior. 

 

21) Printing a form that contained an HTML Viewer control did not print the Viewer control. This has 

been fixed, however, due to the way the Viewer is implemented, printing quality may poor and 

pixilated. 

 


